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Introduction

Welcome to Adobe Dreamweaver CS5 On Demand, a visual
quick reference book that shows you how to work efficiently
with Dreamweaver CS5.  This book provides complete cover-
age of basic to advanced Dreamweaver skills.

How This Book Works
You don’t have to read this book in any particular order.
We’ve designed the book so that you can jump in, get the
information you need, and jump out. However, the book does
follow a logical progression from simple tasks to more com-
plex ones. Each task is presented on no more than two facing
pages, which lets you focus on a single task without having
to turn the page. To find the information that you need, just
look up the task in the table of contents or index, and turn to
the page listed. Read the task introduction, follow the step-
by-step instructions in the left column along with screen illus-
trations in the right column, and you’re done.

What’s New
If you’re searching for what’s new in Dreamweaver CS5, just
look for the icon: New!. The new icon appears in the table of 
contents and throughout this book so you can quickly and
easily identify a new or improved feature in Dreamweaver
CS5. A complete description of each new feature appears in
the New Features guide in the back of this book.

Keyboard Shortcuts
Most menu commands have a keyboard equivalent, such as
Ctrl+P (Win) or A+P (Mac), as a quicker alternative to using
the mouse. A complete list of keyboard shortcuts is available
on the Web at www.perspection.com.

How You’ll Learn

How This Book Works

What’s New

Keyboard Shortcuts

Step-by-Step Instructions

Real World Examples

Workshops

Adobe Certified Expert

Get More on the Web

www.perspection.com
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Step-by-Step
Instructions
This book provides concise step-
by-step instructions that show you
“how” to accomplish a task. Each
set of instructions includes illus-
trations that directly correspond to
the easy-to-read steps. Also
included in the text are time-
savers, tables, and sidebars to
help you work more efficiently or
to teach you more in-depth infor-
mation. A “Did You Know?” pro-
vides tips and techniques to help
you work smarter, while a “See
Also” leads you to other parts of
the book containing related infor-
mation about the task. 

Real World Examples
This book uses real world exam-
ple files to give you a context in
which to use the task. By using
the example files, you won’t waste
time looking for or creating sam-
ple files. You get a start file and a
result file, so you can compare
your work. Not every topic needs
an example file, such as changing
options, so we provide a complete
list of the example files used
throughout the book. The example
files that you need for project
tasks along with a complete file
list are available on the Web at
www.perspection.com.

Real world
examples help
you apply what
you’ve learned
to other tasks.

Illustrations
match the
numbered
steps.

Numbered
steps guide
you through
each task.

Did You Know? alerts
you to tips, techniques
and related information.

See Also points you to
related information in
the book.

Easy-to-follow
introductions
focus on a
single concept.

www.perspection.com


The Workshops
walk you through
in-depth projects
to help you put
Dreamweaver to
work.

Introduction xix

Workshops
This book shows you how to put
together the individual step-by-
step tasks into in-depth projects
with the Workshop. You start each
project with a sample file, work
through the steps, and then com-
pare your results with a project
results file at the end. The Work-
shop projects and associated files
are available on the Web at
www.perspection.com.

Adobe Certified Expert
This book prepares you fully for
the Adobe Certified Expert (ACE)
exam for Adobe Dreamweaver
CS5. Each Adobe Certified Expert
certification level has a set of
objectives, which are organized
into broader skill sets. To prepare
for the certification exam, you
should review and perform each
task identified with an ACE objec-
tive to confirm that you can meet
the requirements for the exam.
Information about the ACE pro-
gram is available in the back of
this book. The Adobe Certified
Expert objectives and the specific
pages that cover them are 
available on the Web at 
www.perspection.com.

www.perspection.com
www.perspection.com
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Get More on the Web
In addition to the information in
this book, you can also get more
information on the Web to help
you get up to speed faster with
Dreamweaver CS5. Some of the
information includes: 

Transition Helpers
◆ Only New Features.

Download and print the new
feature tasks as a quick and
easy guide.

Productivity Tools
◆ Keyboard Shortcuts.

Download a list of keyboard
shortcuts to learn faster ways
to get the job done. 

More Content
◆ Photographs. Download

photographs and other
graphics to use in your
Dreamweaver documents. 

◆ More Content. Download
new content developed after
publication.

You can access these additional
resources on the Web at
www.perspection.com.

Additional
content
is available
on the Web. 

Additional
content
is available
on the Web. 

www.perspection.com
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Viewing the HTML Behind
the Page

Introduction

In the world of the Internet, the graphics, text, animation, and
all the "stuff" that the visitor sees displayed in their browser
is the front end of a Web page, and the power behind the
page is the HTML code. The HTML code sits quietly behind
the scenes, letting the front end get all the credit; however,
without the code, the Internet would fall apart. It's the cosmic
glue that holds the whole thing together.

Designers, like myself, remember when there were no
graphical design interfaces (like Dreamweaver), and all Web
pages were designed code line, by tedious code line. I
remember working by candlelight into the wee hours of the
morning, until I thought my head was going to burst… okay,
so maybe I didn't use candles, but it was a lot of painstaking
work. Although Dreamweaver changed all of that with its
intuitive graphical design interface, the code is still there.
However, we're not the ones doing the coding, Dreamweaver
is… and isn't that nice?

What You’ll Do

Understand HTML

Use the Reference Panel

Use Code View

Use Live Code View

Set Code View Options

Enter HTML Code

Use Code Hints

Work with HTML Head Tags

Insert HTML Comments

Use the Coding Toolbar

Use Quick Tag Editor

Use the Tag Inspector and Chooser

Open Related Files

Navigate to Related Code

Set Site Specific Code Hints

Set Code Hint Preferences

Set Code Format Preferences

Set Code Rewriting Preferences

Set Code Color Preferences
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HTML stands for the HyperText Markup
Language. HTML code is the major language
of the Internet's World Wide Web. Web sites
and Web pages are written in HTML code.
With HTML code and the World Wide Web,
you have the ability to bring together text,
pictures, sounds, and links... all in one place!
HTML code files are plain text files, so they
can be composed and edited on any type of
computer... Windows, Mac, UNIX, whatever.

HTML documents look a lot like word pro-
cessing documents. You can have text that's
bold and italicized, larger and smaller, or it
can look typewritten. The HTML code might
look something like this:

You can have <b>bold</b> and <i>itali-
cized</i>, <font size=+2>Larger</font> and <font
size=-2>Smaller</font>, or it could look <tt>type-
written</tt>.

Most HTML code is enclosed within braces
< >, and when you place the code between
the braces it's said to be a tag. An HTML tag
is code inserted in a document that specifies
how the document, or a portion of the docu-
ment, should be formatted. For example, the
<b> tag is saying to start bold text, and the
</b> tag is saying to stop bold text. The tag
with the slash (/) is known as the closing tag.
Many opening tags require a following clos-
ing tag, but not all do. Tags make up the
entire structure of an HTML document.

HTML files are just normal text files; they
usually have the extension of .htm, .html, or
.shtml. HTML documents have two parts, the
head and the body. The body is the larger part
of the document, as the body of a letter you
would write to a friend. The head of the docu-
ment contains the document's title and simi-
lar information, and the body contains most
everything else. 

Here’s an example of a basic HTML docu-
ment:

<html>

<head><title>Title goes
here</title></head><body>Body goes here</body>

</html>

You may find it easier to read if you add
extra blank lines such as follows...

<html>

<head>

<title>Title goes here</title>

</head>

<body>

Body goes here

</body>

</html>

Understanding HTML

Symbol Defines

<html> Start of the HTML document

<head> The document heading

<body> The body of the document

<title> The document title

<div> A section in a document

<span> A section in a document

<h1> Text heading

<p> A paragraph

<style> Format of text

<img> An image placeholder

<a> A hyperlink

<iframe> An inline frame

<!-- comment --> A comment

Common Tags
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HTML page in Code view HTML page in Design mode

Extra spaces and line breaks (blank lines) are
ignored when the HTML is interpreted (dis-
played) by a Web browser, such as Microsoft
Explorer or Apple Safari... so add them if you
wish.

When working with HTML code, it's all
about the tags. The HTML tags instruct the
text how to look and how it's formatted. In
addition, tags control graphics, animation, in
short… everything. For example the following
uses the <b> or bold tag:

The cow jumped <b>OVER</b> the moon.

When displayed within a browser it would
look like this:

The cow jumped OVER the moon.

The start tag <b> instructs the text follow-
ing the tag to use boldface; the end tag </b>
instructs the text to stop boldface and return
to normal.
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Using the Reference
Panel

Access the Reference Panel

Open Dreamweaver (do not open a
document).

Click the Window menu, point to
Results, and then click Reference.

Select information based on the
following options:

◆ Click the Select Book list arrow
to select from the list of
available reference manuals.

◆ Click the Select Tag list arrow
to select from a list of available
HTML tags.

◆ Click the Select Attribute icon
to choose from a list of
available attributes for the
selected tag.

The reader window displays the
information based on your
selections.

3

2

1

It doesn't matter whether you're an experienced Web designer, or a
newcomer to the field. Sooner or later you're going to need a bit of
help, in the form of reference material. I'll admit that I'm a big reader…
I love to read. I have a library full of books on creativity and design.
Unfortunately, I can't carry all those books with me when I'm on a lec-
ture tour. That's why one of my favorite features in Dreamweaver is the
Reference panel. The Reference panel gives you instant (on screen)
access to 10 O'Reilly reference manuals, 2 Adobe manuals, and a
UseableNet Accessibility Reference. Now that's a lot of reading mate-
rial, and instant information at your fingertips. For example, you're cod-
ing a page, and you need a bit more information on the HTML body
tag… it's there, or you need a bit of help with the new syntax of
XHTML… it's there. As a matter of fact, when you first open the
Reference panel, the information displayed is based on the selected
element on the active Web page.

3

2

Reference information
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Access Specific Information

Open the Web page you want to
access specific information.

Perform one of the following:

◆ Code View. Select a specific
HTML tag, CSS style rule, or
other HTML text.

◆ Split View. Select an item in
the Code pane or select an
object or text in the Design
pane.

◆ Design View. Select an object,
graphic, or portion of text.

Select the element for which you
want specific information.

Press Shift+F1 (Shortcut for
accessing the Reference panel).

The panel opens and displays
information about the selected
page element.

4

3

2

1 1

Reference information for
the selected element

32

Did You Know?
You can search for tags, attributes, or
text in code. Click the Edit menu, click
Find And Replace, specify the Find in
document, select Source Code in the
Search list arrow, enter the text you
want to find, enter the replace text
(optional), specify any options, and
then click the Find or Replace buttons
you want.

You can save and reuse searches.
Click the Edit menu, click Find And
Replace, set the search criteria you
want, click the Save Query button (the
disk icon), navigate to the folder where
you want to save the search, and then
click Save. To reuse a search, click the
Load Query button (the folder icon),
navigate to the folder with the saved
search query file, select it, click Open,
and then use the Find or Replace but-
tons you want.
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Dreamweaver utilizes three document code views: Code and Design,
Code, and Split Code. The Code and Design view gives you a look at the
code and the visual design, the Code view gives you a straight look at
the HTML code of your Web page, and the Split Code view gives you a
multi-pane look at the HTML code. When you work in any of the code
views, you're going back to the basics of Web design… the actual
code that makes it all happen. Some designers never look at the code,
and some designers claim that you can't be good at creating Web
pages without knowing the code. To be honest, I'm in the second camp.
I believe that to really understand the design of a Web page, you need
to know how the code makes a page function.

Using Code View

Access the Code View

Open the Web page you want to
view code.

Access the Code view using one
of the following methods:

◆ Code and Design View. Click
the View menu, and then click 
Code and Design, or click the
Split View button on the
document window. 

◆ Code View. Click the View
menu, and then click Code, or
click the Code View button on
the document window. 

◆ Split Code View. Click the View
menu, and then click Split
Code.

The document view changes to
display the current page code.

To change the placement of
content in a split screen, click the
View menu, and then click Split
Vertically (horizontal when
unchecked), or Design View on
Left or Design View on Top.

3

2

1
1 Code in Split view

Did You Know?
You can adjust the size of the panes in
Split view. Drag the splitter bar
located between the two panes.

23

Split views appear
vertically by default.
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View Code in a Separate
Window Using Code Inspector

Open the Web page you want to
view code.

Click the Window menu, and then
click Code Inspector.

Use the toolbar to select from the
following options:

◆ File Management. Get, put,
check in or check out a file.

◆ Preview/Debug In Browser.
Preview or debug the file in a
browser or Device Central. 

◆ Refresh Design View.
Refreshes Design view to
reflect code changes in Code
view.

◆ Reference. Opens the
Reference panel.

◆ Code Navigation. Allows you to
move quickly in the code.

◆ View Options. Allows you to
change the way code appears
in Code view. 

When you’re done, click the Close
button.

4

3

2

1

1 2

43

Did You Know?
You can use the coder-oriented work-
space. The workspace displays the
panel groups docked on the left side of
the main window, and the Document
window appears in Code view. The
Properties panel is collapsed. Click the
Window menu, point to Workspace
Layout, and then click Coder.
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As you work in Live view, you can also view live code. Similar to Live
view, Live Code view is a non-editable view. Live code view appears
displaying the code that the browser uses to execute the page. The
non-editable code is highlighted in yellow. If you want to edit the code,
all you need to do is return to Live view, and then switch to Code view,
which is editable. After making your code changes, you can return to
Live view and then refresh it to see your changes.

Using Code Live View

Access Live Code View

Open the Web page you want to
view.

Switch to Design view or Code and
Design view. 

Click the Live View button.

To go to Live Code view, click the
Live Code button.

Live code view appears displaying
the code that the browser uses to
execute the page. The non-
editable code is highlighted in
yellow.

To return back to Live view, click
the Live Code button again.

To return back to Design view,
click the Live View button again.

6

5

4

3

2

1

Did You Know?
You can print code. Open the Web
page you want to print in Code view,
click the File menu, click Print Code,
specify the options you want, and then
click OK (Win) or Print (Mac).

1 2 3

4 6

See Also
See “Previewing Pages in Live View”
on page 32-33 for more information on
viewing pages in Live View and Live
Code View.
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You can select Code view options to change the way code appears in
Code view. When you select the Code View Options command on the
View menu or use individual buttons on the Code toolbar, you can set
options to set word wrapping, display line numbers, hide characters,
highlight invalid code, color code, indent code automatically, and dis-
play syntax error alerts in the Info bar.

Setting Code View
Options

Use Code View Options

Open the Web page you want to
view code.

Switch to the Code view.

Click the View menu, point to Code
View Options, and then select
from the following options:

◆ Word Wrap. Forces the HTML
code to wrap, based on the
width of the Code view window. 

◆ Line Numbers. Displays line
numbers to the left of the HTML
code.

◆ Hidden Characters. Displays
hidden code elements, such as
tabs and character returns. 

◆ Highlight Invalid Code.
Highlights any code that
Dreamweaver considers
incorrect.

◆ Syntax Coloring. Colorizes the
HTML code, to visibly separate
it from the text.

◆ Auto Indent. Automatically
indents the HTML code to aid in
readability. 

◆ Syntax Error Alerts in Info Bar.
Displays syntax code error
alerts in the Info bar. 

3

2

1 1 2

3
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Entering HTML Code

Enter HTML in Code View

Open the Web page you want to
view code.

Switch to the Code view.

Click to the right of a tag and press
Enter to create a space between
the opening and closing body tag.

Enter the HTML code you want on
the new line.

◆ Code Hints. When you type the
left brace "<" the Code Hints
popup menu appears, listing all
possible HTML codes. Begin
entering in the code name, and
Code Hints will display the
correct code. Double-click it or
select it and  press Enter (Win)
or Return (Mac) to add the tag.

TIMESAVER Press
Control+Spacebar to display a
Code Hints popup menu or press
Esc to close the Code Hints menu.

To indent the selected code, press
Tab; to outdent the selected code,
press Shift+Tab.

To add a closing tag, type a left
brace and forward slash "</", and
Dreamweaver will automatically
insert the correct closing tag.

To remove a tag, right-click in the
tag, and then click Remove Tag.

7

6

5

4

3

2

1

You can enter HTML code in Code view like you are typing text into a
word processor. However, when you type HTML code, it uses a specific
structure and layout. As you type, the Code Hints popup menu appears
to help you enter correct HTML code tag names, attributes, and values
as you type code in Code view or the Quick Tag Editor. For example,
when a tag requires the selection of a color, Dreamweaver displays a
color palette. When a font is required, a font list is automatically dis-
played, and when a file is required a browse button magically appears
allowing you to select and insert the file. If a page does contain invalid
code, it appears in Design view and optionally highlights in Code view.
When you select the invalid code, the Properties panel displays infor-
mation as to why the code is invalid and steps to fix it. 

34 Code hints

1 2
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Code hints makes it easy to insert and edit code accurately in a variety
of languages. Dreamweaver supports code hinting for the following lan-
guages and technologies: HTML, CSS, DOM, JavaScript, Ajax, Spry,
Adobe ColdFusion, JSP, PHP (New! for functions, variables, and classes
and tooltip help), MySQL, ASP JavaScript, ASP VBScript, ASP.NET C#,
and ASP.NET VB. As you start to type code for a particular code type,
the Code Hints popup menu appears to help you enter it correctly. When
you type a right angle bracket (<), code hint displays HTML tag names.
When you type a period (dot operator) after an object, code hint dis-
plays JavaScript code possibilities. Dreamweaver also provides code
hinting for your own or third-party custom JavaScript classes that are
not built in to the language. If Dreamweaver detects problems with your
code, code hints doesn’t always work properly. Use the Syntax Error
Information Bar to help you fix the code problems.

Using Code Hints

Use Code Hints

Open the Web page you want to
view code.

Place the insertion point where
you want to add code.

Start to type the code you want or
press Control+Spacebar to
manually display the code hints
popup menu.

Scroll through the list by using the
scroll bar or pressing the Up
Arrow and Down Arrow keys.

To insert a code hint, double-click
an item, or select it and then press
Enter (Win) or Return (Mac).

◆ Press Backspace (Win) or
Delete (Mac) to dismiss the list
of code hints. 

To edit code, delete the code, and
then start typing what you want to
use for code hints.

6

5

4

3

2

1

See Also
See “Setting Code Hint Preferences”
on page 344 for more information on
setting options for code hints.

1 2

Code hints
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Working with HTML
Head Tags

View and Insert Head Tags

Open the Web page you want to
view and change head properties.

To insert head tags, click the Insert
menu, point to HTML, point to
Head Tags, and then select the tag
you want: Meta, Keywords,
Description, Refresh, Base, or Link.

Enter the information or specify
the options you want, and then
click OK.

Click the View menu, and then
click Head Content.

To edit an element, click one of the
icons in the head section to select
it, and then change the properties
you want in the Properties panel.

5

4

3

2

1

Each page contains information about the document in the head sec-
tion. You can set the properties of head elements to control how your
pages are identified on the Web by search browsers. You can insert the
following head tags: meta, keywords, description, refresh, base, or link.
A meta tag records information about the current page, such as encod-
ing, author, copyright, or keywords. The keywords and description tags
record information many search engines, such as Google or Yahoo,
look for to create an index for your page for use in their search results
databases. For the best results, specify a few descriptive keywords and
a short description for a page. The refresh tag specifies the amount of
time before the page is refreshed in a browser. The base tag sets the
base URL that all document-relative paths in the page use. The link tag
defines a relationship between the current page and another file. After
you insert a head tag, you can always make changes and adjustments
by using the head content, selecting the head element, and making
changes in the Properties panel. 

1 5

Edit keywords in the Properties panel

4 2

3

Did You Know?
You can check for balanced tags and
braces. In Code view, click to place the
insertion point where you want to
check, click the Edit menu, and then
click Select Parent Tag or Balance
Braces. You can select the commands
again to check the next level out.
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Inserting HTML
Comments

Insert HTML Comments

Open the Web page you want to
insert comments.

Click to place the insertion point
where you want to insert a
comment (in Code or Design view).

Click the Insert menu, and then
click Comment.

Type the comment you want.

Click OK (in Design view).5

4

3

2

1

If you’re writing large sections of code or working with other people to
develop a site, it’s important to insert comments into your HTML code.
An HTML comment is descriptive text that explains the purpose and
process for the page’s code. The comment text only appears in Code
view; the information is for internal development purposes only. You
can insert comments in Code view or Design view. After you insert a
comment, you can edit it directly in Code view, or select the comment
marker and make changes in the Properties panel.

1

2

43

5

See Also
See “Working with Invisible Elements”
on page 88 for information on display-
ing comment markers in Design view.

Did You Know?
You can change the code using the
Selection submenu. Select the code
you want in Code view, right-click
(Win) or control-click (Mac) it, point to
Selection, and then click the selection
command you want.

You can copy and paste code. Copy
the code from Code view or from
another program, click to place the
insertion point in Code view where you
want to paste the code, click the Edit
menu, and then click Paste.



When you switch to Code or Split view, the Coding toolbar appears
along the left side of the Code view pane. The toolbar provides easy
access to the most common coding related commands. If the Code
view pane is not large enough, an expander arrow appears, which you
click to access additional buttons. Some of the tools allow you to col-
lapse and expand the content between a set of opening and closing
tags, select tags, insert and remove comments, format code, and high-
light invalid code.
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Using the Coding
Toolbar

Use the Coding Toolbar

Open the Web page you want to
view code.

Switch to Code or Split view.

Click to place the insertion point in
the code or select a block of code.

Click the button you want on the
Coding toolbar:

◆ Open Documents. Displays a
list of open documents. Click
the one you want to open it. 

◆ Show Code Navigator. Displays
the Code Navigator in the code. 

◆ Collapse Full Tag. Collapses
the content between a set of
opening and closing tags. You
need to place the insertion
point in the opening or 
closing tag. 

◆ Collapse Selection. Collapses
the selected code.

◆ Expand All. Restores all
collapsed code. 

◆ Select Parent Tag. Selects the
code tag immediately outside of
the line with the insertion point.

◆ Balance Braces. Selects the
code tag and surrounding
parentheses, braces, or square
brackets of the line with the
insertion point.

◆ Line Numbers. Shows or hides
the numbers at the beginning of
each line of code.

4

3

2

1

4

1 2

3
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◆ Highlight Invalid Code.
Highlights invalid code in
yellow.

◆ Syntax Error Alerts in Info Bar.
Displays syntax code error
alerts in the Info bar.

◆ Apply Comment. Inserts
comment tags around the
selected code, or opens new
comment tags.

◆ Remove Comment. Deletes
comment tags from the
selected code. 

◆ Wrap Tag. Wraps selected
code with the selected tag from
the Quick Tag Editor.

◆ Recent Snippets. Inserts a
recently used code snippet
from the Snippets panel.

◆ Move or Convert CSS. Moves
CSS to another location or
converts inline CSS to CSS
rules.

◆ Indent Code. Shifts the
selection to the right.

◆ Outdent Code. Shifts the
selection to the left.

◆ Format Source Code. Displays
options to apply source code
formatting to selected code, or
to the entire page if no code is
selected. You can also access
Code Format Settings from the
Preferences dialog box or the
Tag Library Editor.

TIMESAVER You can perform
many of these same commands on
the Insert panel.

Show Code Navigator
Collapse Full Tag

Collapse Selection

Select Parent Tag

Line Numbers

Remove Comment

Recent Snippets

Indent Code

Format Source Code

Expand All

Balance Braces

Highlight Invalid Code

Apply Comment

Wrap Tag

Move or Convert CSS

Outdent Code

See Also
See “Moving CSS Rules” on page 226
for information on moving CSS rules to
a style sheet.

Open Documents

Syntax Error Alerts in Info Bar

Identifying Syntax Errors
If you open a page with syntax errors, Dreamweaver displays a
semi-transparent red color to mark the code view gutter on all the
lines that have syntax errors. In addition, Dreamweaver displays an
alert message in the Info bar to inform you the first error line num-
ber and warn you that code hinting might not work property. It’s
important to know that even though all errors are shown, often only
the first error is the real error location. The rest of the errors are an
indirect consequence of the first error. 

For Your Information
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Using Quick Tag 
Editor

Open the Quick Tag Editor

Open the Web page you want to
view code.

Open the Quick Tag Editor using
any of the following methods:

◆ Click the Modify menu, and
then click Quick Tag Editor.

◆ Use the keyboard shortcut
Ctrl+T (Win) or A+T (Mac).

◆ Click the Quick Tag Editor icon
in the Properties panel. 

2

1

Creating Web documents in the Design view is a beautiful and elegant
way to design Web pages; however, sometimes you just need to get
under the hood and make changes directly to the code. Dreamweaver
gives you a way to make alterations to the code using the Quick Tag
Editor. When activated, the Quick Tag Editor displays as a small pop-up
window and allows you to edit a tag, add a tag, or enclose the current
selection within a tag. In addition, you can use a list of tags and attrib-
utes to help jog your HTML memory, and save you some typing.
Dreamweaver's Quick Tag Editor can be used in three ways: Insert
HTML (used for adding new tags and code at the current cursor posi-
tion), Wrap Tag (wrap one tag around one or more other tags and con-
tent) and Edit HTML (displays the entire selected tag with all the
attributes). It is a great time-saver for making those small tweaks to the
code of any Web document. While most designers will perform most of
the creative process using the Design view, it's nice to know that you
have a powerful tool like the Quick Tag Editor when you need to get
back to coding basics.

1

Quick Tag Editor

Did You Know?
Dreamweaver helps you with the syn-
tax of the code. If you fail to add the
quotation marks around a parameter’s
value, the Quick Tag Editor will do it for
you. If you want to add more than one
tag, you can use the right arrow key to
move beyond the first set of braces in
the Quick Tag Editor. Then, simply enter
in a left brace and add the additional
tag.

2
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Use Quick Tag Editor in Wrap
Tag or Insert HTML Mode

Open the Web page you want to
view code.

Select a portion of text within the
document (for Wrap Tag mode) or
click in the text area (do not select
any text) to place an insertion
point (for Insert HTML mode).

Open the Quick Tag Editor.

Use the HTML tags in the pop-up
hint list to insert a tag, or manually
enter a customized XML tag.

Press Enter (Win) or Return (Mac)
to wrap the selected text with the
tag.

Use Quick Tag Editor in Edit Tag
Mode

Open the Web page you want to
view code.

Select a complete tag in Code
view (e.g., img), or select an
object, such as an image, in
Design view.

Open the Quick Tag Editor.

The tag with all its attributes will
be displayed within the Quick Tag
Editor window.

Manually enter any changes to the
tag and attributes.

Press Enter (Win) or Return (Mac)
to add the tag to the document.

5

4

3

2

1

5

4

3

2

1

3

1

4

2
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Using the Tag
Inspector

Access the Tag Inspector

Open the Web page you want to
view in the Tag Inspector.

Make a selection using one of the
following methods:

◆ Code View. Select a specific
HTML tag or section of text.

◆ Split View. Select a HTML tag
in the Code pane or select an
object in the Design pane.

◆ Design View. Select an object
in the window, or create a
selection of text.

Click the Window menu, and then
click Tag Inspector to display the
Tag Inspector.

Select from the following views:

◆ Category View. Displays a list
of general categories within
collapsible headings. Click the
plus (+) or minus (-) sign icon to
display all available attributes.

◆ List View. Displays a list of all
available attributes for the
selected Web element. 

Select the attribute that you want
to add or modify, and enter the
correct value in the input field.

Press the Enter key to record your
changes.

6

5

4

3

2

1

Dreamweaver's Tag Inspector gives you control over your code by dis-
playing a collapsible outline of the tags used on the current page. This
feature allow you to quickly determine if tags are correctly nested, and
to view and change tag attributes. For example, you may want to
change the attributes of the <body> tag, or change the overall color
and size of the default font; both these and many more options are
available using the Tag Inspector. When selected, the Tag Inspector
displays a collapsible structure of all the attributes within the selected
Web element. This view gives you an overall view of the code and how
it's laid out. When you select a tag, all the attributes for that tag are
displayed for you to view and edit. 

1

Selected element

Tag Inspector2 43

5
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Using the Tag Chooser

Insert Tags Using the Tag
Chooser

Open the Web page you want to
insert a tag using the Tag Chooser.

Click to place the insertion point in
the code where you want to insert
a tag.

Right-click (Win) or control-click
(Mac) near the insertion point, and
then click Insert Tag.

Select a category of tags from the
tag library, or expand the category
and select a subcategory.

Select a tag from the right pane.

To view syntax and usage
information for the selected tag,
click Tag Info.

To insert the selected tag into your
code, click Insert.

If a tag requires more information,
enter the required information in
the tag editor, and then click OK.

Click Close.9

8

7

6

5

4

3

2

1

The Tag Chooser allows you to insert any tag from the Dreamweaver
tag libraries in your page. A tag library is a collection of tags for a cer-
tain type that contains tag information, code hints, target browser
checks, and other features. You can insert tags from the following
types: HTML, CFML, ASP.NET, JSP, JRun custom library, ASP, PHP, and
WML. If you are looking for a specific tag in a specific category, the
Tag Chooser can help you insert it into your code with the right syntax.

2 31

6

9

4

5

7

Did You Know?
You can add or remove tags, attributes,
and libraries from the Tag Library.
Click the Edit menu, click Tag Libraries,
click the Plus (+) or Minus (-) buttons
to select commands to add or remove
tags, attributes, and libraries.
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Opening Related Files

Set Related Files Preferences

Click the Dreamweaver (Mac) or
Edit (Win) menu, and then click
Preferences.

Click the General category.

Select the Enable Related Files
check box.

Click OK to the alert. The change
takes effect after restarting
Dreamweaver.

Click the Discover Dynamically-
Related Files list arrow (New!),
and then select an option:

◆ Automatically. Displays static
and dynamically-related files on
the Related Files toolbar.

◆ Manually. Displays static
related files and displays the
Info bar for dynamic-related
ones. Click the Discover link on
the Info bar to display it on the
Related Files toolbar.

◆ Disabled. Turns off the
discovery of dynamically-
related files. Static related files
are still displayed.

Click OK.6

5

4

3

2

1

If you have a related file attached to a document, you can use the
Related Files toolbar to quickly open it while keeping the main page
available. When the Enabled Related Files option and an Discover
Dynamically-Related Files option is selected in General Preferences,
Dreamweaver displays the names of all static and dynamically (New!)
related files related to a main document in a Related Files toolbar. The
related files include external CSS rules, server-side includes (multi-
level), PHP files, external JavaScript files, parent templates files, library
files, and iframe source files. Status files appear first starting from the
left, followed by external files (such as .css and .js), and concluding
with dynamic path server included files (such as .php, .inc, and .mod-
ule). When the Related Files toolbar contains too many files to fit on
the toolbar, scroll arrows appear on the right and left to access files.
To help you reduce the number of files on the toolbar, you can filter
files by type to hide the ones you don’t want to display. In addition,
when you click a link to a code source file in the Code Navigator, the
file appears in the related files area (if enabled).

6

2

5

3
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Use the Related Files Toolbar

◆ Open a Related File. Click a file
named button on the Related Files
toolbar. 

◆ Open a Related File as a Separate
File. Right-click (Win) or Control-
click (Mac) a file named button on
the Related Files toolbar, and then
click Open as Separate File.

◆ Return to the Main Document
Source Code. Click the Source
Code button on the Related Files
toolbar.

◆ Filter Files on the Toolbar. Click
the Filter Related Files button
(New!) on the Related Files
toolbar, and then select the file
types you want to filter (checked
to show or unchecked to hide) or
click Show All File Types to show
all files. 

The list of file types on the menu
is built based on the file types
connected to the current open
document. You cannot filter out all
the file types. When you close a
document, the filter settings are
not saved.

Related Files toolbar with buttons to access files

Using the Info Bar
The Info bar is a yellow bar that appears across the top of the main
document window, below the Document toolbar when certain types
of errors occurs in Dreamweaver. The Info bar (New!) shows infor-
mation error messages for dynamically-related files, Live View, stan-
dard related files, code hinting, etc. For example, if a related file
doesn’t exist locally, the Info bar displays a Get link to download the
file, or if a related file isn’t checked out by you, the Info bar displays
a Checkout link to check out the files. Multiple Info bar messages
can be displayed. Clicking the scroll arrows takes you to the next
Info bar message. In Code view, the Info bar displays error mes-
sages in the current document. If you don’t way to view the errors,
you can turn them off by using the Syntax Error Alerts In Info Bar
button on the Coding toolbar. 

For Your Information

Filter Related
Files button

Filter settings
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Navigating to Related
Code

Open the Code Navigator

Open the Web page you want to
view.

Alt-click (Win) or command-
option-click (Mac) anywhere on
the page.

◆ You can also click the Code
Navigator indicator icon to
open the Code Navigator. The
Code Navigator indicator icon
appears near the insertion
point when the mouse remains
idle for 2 seconds.

The Code Navigator displays links
to the code related to the section
of the page you clicked. The code
sources are grouped by file and
listed alphabetically.

Click a link to display it in the
related files area or open it as a
separate file in the Document
window.

To close the Code Navigator, click
outside of it.

4

3

2

1

Code Navigator displays a list of linked code sources related to a part
of a page. The related codes sources include internal and external CSS
rules, server-side includes, external JavaScript files, parent templates
files, library files, and iframe source files. When you click a linked code
source, the file appears in the related files area (if enabled) or opens as
a separate file in the Document window. If the code source is an inter-
nal CSS rule, the rule appears in Split view. You can open Code
Navigator from Design, Code, and Split views and the Code Inspector.

Did You Know?
You can enable or disable the Code
Navigator indicator. Alt-click (Win) or
command-option-click (Mac) on a
page, select or clear the Disable
Indicator check box, and then click
outside to close the Code Navigator. 

1 2 4

3
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Setting Site Specific
Code Hints

Set Site Specific Code Hints

Open a PHP page, and make sure
a server site is set up.

Click the Structure list arrow, and
then select a built-in option
(Drupal, Joomla, or Wordpress), or
click <New from blank> to create
your own.

Click the Browse for Folder icon to
select a sub-root folder for the
configuration file and the base for
searches within the site.

To add or remove a file or folder to
your site scan, click the Plus
button, specify a file or folder, and
then click Add, or select a file or
folder, and then click the Minus
button.

Use any of the following:

◆ Scan This Folder. Includes the
selected folder in the site scan.

◆ Recursive. Includes subfolders
when a folder is selected.

◆ Extensions. Specifies the file
extensions to check.

To manage structures, use the
Import, Save, Rename, or Delete
buttons.

Click OK.7

6

5

4

3

2
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When you’re working with PHP files in Dreamweaver, you can discover
code hints for functions, variables, and classes (New!). The built-in
hint support also includes tooltips with documentation from php.net,
which you can enable in Code Hints preferences. Added dynamic PHP
code hinting support allows you to customize CMS (Content Manage-
ment System) frameworks, like Drupal, Wordpress, and Joomla. If a
PHP code hint is not available by default in Dreamweaver, you can cre-
ate or edit a configuration file in your local site with the site-specific
code hints extension (New!) that allows PHP code hinting to inspect
the specified files and folders for functions, objects, and global vari-
ables you want as code hints. The configuration file, named
dw_php_codehinting.config, is saved to your site’s root.

2 64

5 7

3
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Setting Code Hint 
Preferences

Set Code Hint Preferences

Click the Dreamweaver (Mac) or
Edit (Win) menu, and then click
Preferences.

Click the Code Hints category.

Select from the following check
boxes:

◆ Close Tags. Select an option to
specify how you want to insert
closing tags. The default inserts
tags automatically after you
type the characters </. You can
also insert it after a final
bracket >, or not at all.

◆ Options. Select the Enable
Code Hints check box to use
code hints, and then drag the
slider to set the code hints
popup menu delay you want.
Select the Enable Description
Tooltips check box (New!) to
use tooltip help for PHP files.

◆ Menus. Select the check boxes
for the types of code hints you
want to display, and clear the
others you don’t want.

IMPORTANT Even if you
disable code hints, you can display
a popup hint in Code view by
pressing Control+Spacebar.

To add or remove tags and
attributes, click the Tag Library
Editor link.

Click OK.5

4

3

2

1

You can use the Code Hint section of the Preferences dialog box to set
options for the Code Hints popup menu. Code Hints does more than help
you type in a simple HTML code tag. It helps you insert tag names,
attributes, and values as you type code in Code view or the Quick Tag
Editor. For example, when a tag requires the selection of a color,
Dreamweaver displays a color palette. When a font is required, a font
list is displayed, and when a file is required, a browse button magically
appears allowing you to select and insert the file. If you want additional
tooltip help, you can enable it for php code hints (New!).

5

2

3

4
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Setting Code Format 
Preferences

Set Code Format Preferences

Click the Dreamweaver (Mac) or
Edit (Win) menu, and then click
Preferences.

Click the Code Format category.

Select from the following options:

◆ Indent. Select to have Dream-
weaver indent generated code,
and then specify how many
spaces or tabs to indent.

◆ Tab Size. Specify how many
spaces for a tab character.

◆ Line Break Type. Select the 
type of remote hosting server
(Windows, Macintosh, or UNIX).

◆ Default Tag Case and Default
Attribute Case. Select
<lowercase> or <uppercase>.

◆ Override Case Of: Tags and
Attributes. Select whether to
override your case settings.

◆ TD Tag: Do Not Include A Break
Inside The TD Tag. Select to
prevent problems with white
space and line breaks on older
browsers.

◆ Advanced Formatting. Click to
set formatting options for CSS
code and individual tags and
attributes in the Tag Library
Editor.

Click OK.4

3

2

1

You can use the Code Format section of the Preferences dialog box to
change the way your code looks in Code view. The options you set in
the Code Format section, except the Override Case Of option, are auto-
matically applied only to new documents or additions to documents you
create in the future. If you want to reformat an existing document, you
can use the Apply Source Formatting on the Commands menu.

4

2

3
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Setting Code
Rewriting
Preferences

Set Code Rewriting Preferences

Click the Dreamweaver (Mac) or
Edit (Win) menu, and then click
Preferences.

Click the Code Rewriting category.

Select from the following options:

◆ Fix Invalidly Nested and
Unclosed Tags. Select to
rewrite overlapping or
transposed tags and inserts
closing quotation marks and to
insert closing brackets as
needed.

◆ Rename Form Items When
Pasting. Select to prevent
duplicate names for form
objects.

◆ Remove Extra Closing Tags.
Select to delete closing tags
that don’t have an associated
opening tag.

◆ Warn When Fixing Or
Removing Tags. Select to
display a summary of invalid
HTML code Dreamweaver
wants to fix.

◆ Never Rewrite Code: In Files
With Extensions. Select to
prevent code rewriting in files
with specific file extensions,
and then specify the files
extensions you want separated
by a space.

3

2

1

You can use the Code Rewriting section of the Preferences dialog box
to specify how and if Dreamweaver changes your code. Some of the
rewriting options allow you to fix invalid nesting and unclosed tags;
prevent duplicate names for form objects; ensure attributes values and
URLs contain legal characters; and add the right JavaScript tags upon
opening active content files. These options have no effect when you
edit your code in Code view. If you disable the rewriting options, invalid
HTML code that would have been rewritten is displayed in the
Document window.

2

3
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◆ Encode <, >, &, And “ In
Attribute Values Using &.
Select to make sure attribute
values you enter outside Code
view contain legal characters. 

◆ Do Not Encode Special
Characters. Select to prevent
Dreamweaver from changing
URLs to use only legal
characters.

◆ Encode Special Characters In
URLs Using &#. Select to make
sure URLs you enter outside
Code view contain legal
characters (use the &#
encoding method).

◆ Encode Special Characters In
URLs Using %. Select to make
sure URLs you enter outside
Code view contain legal
characters (use the %
encoding method).

Click OK.4

4

3
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Setting Code Color 
Preferences

Set Code Color Preferences

Click the Dreamweaver (Mac) or
Edit (Win) menu, and then click
Preferences.

Click the Code Coloring category.

Click any of the color boxes, and
then select a color.

◆ Default Background. Default
Code view background color.

◆ Hidden Characters. Hidden
character code color. (New!)

◆ Live Code Background. Live
Code view background color.
(New!)

◆ Live Code Changes. Live Code
view code change color.
(New!)

◆ Read Only Background. Read
only background color. (New!)

Click the document type in which
you want to set code colors.

Click Edit Coloring Scheme.

Select the style for the document
type you want to change.

Specify the text color, background
color, and any formatting (Bold,
Italic, or Underline) you want.

The sample code in the Preview
pane displays the new styles and
colors.

Click OK.

Click OK.9
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You can use the Code Coloring section of the Preferences dialog box to
specify colors for general categories of tags and code elements, such
as HTML Image or style tags, Library items, or CSS properties. For a
selected tag or code element, you can specify the text color, back-
ground color, and any formatting (Bold, Italic, or Underline) you want to
make it easier to work with your code. In Code view and Live Code
view (New!), you can specify different colors for backgrounds and
code to make it easier to read.

9
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Index

A
abbreviations, defining, 123
absolute paths, 165
absolute positioning of AP elements, 246
accessibility, 451

adding accessibility, 467
preferences, setting, 466
Remote Info options, 478-481

access keys
for form objects, 305
for links, 169

acronyms, defining, 123
actions. See behaviors; events; snippets
ActionScript files, 79
activating Dreamweaver, 15
active link colors, 83
Active Server Pages, 79

showing/hiding tags, 89
Active Server Plus Pages files, 79
ActiveX controls, using, 290-291
Add Behavior button, 353
addpro Web site, 8
Adobe. See also Flash; Illustrator;

Photoshop
activating Dreamweaver, 15
downloading applications, 13
help resources, 37
manuals, 324

Adobe Acrobat Connect, 298
starting meetings with, 298

Adobe Bridge, 30-31
Adobe BrowerLab, 34-35, 296-297
Adobe Contribute, 475
Adobe CSS Advisor Web site, 234
Adobe Extension Manager

Business Catalyst, 502-503
advanced find and replace. See

finding/replacing

Advanced Site Setup Web site, 473
setting site definitions, 474-475

advertising banners, 134
AIF files, linking or embedding, 286
Ajax framework help, 37
alert dialog box

text, displaying, 364
alias of application, creating, 14
alignment. See also tables

for ActiveX objects, 291
AP elements, 253
CSS properties, setting, 222
elements

anchor points, showing/hiding, 89
AP elements, 253

for Flash/Shockwave movies, 283
forms, image buttons in, 311
with grids and guides, 56
of horizontal rules, 109
images, aligning, 146-147
for Java applets, 289
options for, 146-147
of paragraph text, 106

alpha masks, 149
alternate content

ActiveX objects, images for, 291
for Java applets, 289
text, using, 467

<alt> tags, 469
anchors. See named anchors
AP elements

aligning, 253
borders, showing/hiding, 244
dragging, 370-371
for image map hotspots, 176
introduction to, 242
manually changing CSS-P 

positioning, 246
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AP elements (continued)
manually creating, 243
moving, 253
naming, 248
nesting, 244
outlines, 87
overlapping, preventing, 252
preferences, setting, 245
previewing positioning, 251
properties, modifying, 250-251
resizing, 253
rollovers with, 254-255
Show/Hide Elements action, 350
showing/hiding anchor points for, 89
stacking order

changing, 252
modifying, 253

styles, creating, 247
tables, converting to, 256-257
working with, 252-253
z-index, applying, 249

appearance page properties, setting, 82
appear/fade, 360

spry effects, adding, 396
Apply Source Formatting option, 345
arrow keys in Code view, 513
ASP file tags, inserting, 339
ASP.NET file tags, inserting, 339
ASPX format, 29
assembling site, 7
assets, 408. See also color assets; libraries;

templates; URL assets
favorite assets, working with, 414-415
Favorites folder, grouping assets in, 415
inserting, 410
modifying assets, 411
multiple assets, selecting, 411
previewing, 410
sorting, 414

Assets panel
documents from templates, creating, 24
images, inserting, 134
opening templates from, 430
resizing, 414
working with, 409

attachments. See also templates
external style sheet, attaching, 216

attributes. See also CSS (Cascading Style
Sheets)

legal characters in values, 347
audience

demographic studies, 7
planning for, 3

audio files, linking or embedding, 286-287
autoplay. See Flash
autostretch. See tables
AVI files, linking or embedding, 286

B
Background File Activity dialog box, 495
backgrounds. See also CSS (Cascading

Style Sheets); Flash; tables
of AP elements, 245
properties, setting, 82

balanced code, checking for, 460-461
bandwidth, 472
base tag, 332
Basic Site Definition Wizard, 473
behaviors, 349-350. See also events

changing event for behavior, 357
deleting, 359
downloading third-party behaviors, 354
editing, 366-357
effects, adding, 360-361
entire page, applying to, 354-355
introduction to, 349-351
multiple behavior order, changing, 358
page elements, applying to, 352-353
parameters, editing, 356

Behaviors panel, 352-353
Benguiat font, 91
blank Web page, creating, 21
blinds, 360

spry effects, adding, 396
block snippets. See snippets
<body> tag, 354-355
boldfacing

characters in text, 104
with Copy and Paste Special, 101
copying/pasting, setting for, 102
for headings, 84
for links, 83
table text, 193

BOM (Byte Order Mark), selecting, 63
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Box model, 251
borders. See also CSS (Cascading Style

Sheets); Flash; frames and framesets;
tables

AP element borders, 
showing/hiding, 244

Change Property behavior for, 368
braces < >, 322

balance, checking for, 460-461
Coding toolbar options, 334

brightness of images, 152
broken links, finding and fixing, 452-454
browser compatibility, 458-459

CSS browser compatibility, checking for,
234-235

testing, 353
Browser Compatibility Check (BCC), 234-

235, 458-459
Browser Navigation Bar, 32-33

testing link, 182-183
using, 33

browsers
Code view

compatibility, checking for, 458-459
scripts, inserting browser-safe, 347

colors, browser-safe, 64
editing list of, 35
events, support for, 351
independence, testing for, 451
no frame support, information for

browser with, 265
previewing in, 34-35
relative path for new links, previewing,

166-167
<b> tag, 115, 322
buffers for Flash video, 285
bulleted lists. See ordered/unordered lists
Business Catalyst

download and install, 502
extemsion, 502
panel, 502-503
work with, site, 503

C
cache files

for file/asset information, 477
for link information, 180-181

Call JavaScript behavior, 373
captions. See also Flash elements

table captions, entering, 189
cascading Document window, 39
case sensitivity

of file names, 27
finding/replacing with, 121, 519, 521
of links, 477
for tag find and replace, 521
for text find and replace, 519

cells. See tables
centering

AP elements, centering tables with, 256
paragraph text, 106
selecting options for, 61

CFML files, 29
help, 37
tags, inserting, 339

Change Link Sitewide command, 184
Change Property behavior, 368-369

with text, 363
Change Property Restore behavior, 368

with text, 363
characters, 347. See also case sensitivity

CSS character style, applying, 215
formatting, 104-105
forms, options for, 306
other characters, inserting, 96-97
special characters, inserting, 96

checkboxes. See forms
checking in/checking out site files, 498-499
Check Plug-in behavior, 294-295, 350

Web page, applying to, 355
class ID for ActiveX objects, 291
cleaning up. See HTML (Hypertext Markup

Language)
click and drag for text, 98
click release shift click for text, 98
client-side image maps. See image maps
cloaking/uncloaking, 474, 506

defining site cloaking, 484
closing

panels, 46
Web pages, 39

closing tags, 322
extra closing tags, deleting, 346

CMS, 343
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code. See also HTML (Hypertext Markup
Language); libraries; snippets

for Java applets, 289
for spry effects, 397

Code Coloring section, Preferences dialog
box, 348

Code Hints 
popup menu, 330-331
preferences, 344
site specific code hints, 343

Code Inspector, 327
Code Navigator, 334-335, 342
coder-oriented workspace (Windows), 327
Code view, 30, 31. See also browsers; Tag

inspector
accessing, 326
arrow keys in, 513
assets, dragging, 410
attribute values, legal characters in, 347
balanced tags, checking for, 332
with Code Inspector, 327
Code Navigator, 334-335, 342
Code View Live, 32, 328
Coding toolbar, 334-335
color preferences, setting, 348
comments

deleting, 335
inserting, 333

copying/pasting in, 333
entering HTML in, 330
fonts, selecting, 128
format preferences, setting, 345, 344
head tags, working with, 332
hint preferences, setting, 344
options, setting, 329
Reference panel, accessing in, 325
rewriting preferences, setting, 346
syntax of code, 336
Tag Chooser, using, 339

Code View Live, 32, 328
Coding toolbar, 44, 334-335
ColdFusion. See also CFML files

file formats, 79
help, 37
showing/hiding tags, 89

collapsing. See expanding/collapsing
color assets

displaying, 409

new color asset, adding, 412
text, applying color to, 413

Color Cubes palette, 64
Color dialog box, 64
color picker, 64-65
colors. See also backgrounds; color assets;

Flash; highlighting; tables; text
of AP elements, 245
code color preference, setting, 348
frame border colors, modifying, 274
for headings, 84
for image placeholders, 160-161
images, optimizing colors for, 148-149
for links, 83
palettes, selecting, 64
table colors, setting, 201
unused colors, removing, 149
Web-safe colors, 64
working with, 64-65

Color Sliders, 65
Color Wheel button, 64
columns and rows. See also CSS

(Cascading Style Sheets); tables
File View Columns options, 485

commands, 43
managing History commands, 515
recording commands, 516
running History commands, 514
saving History panel steps as, 512-513
temporary use, recording/playing com-

mands for, 516
Commands menu, Apply Source Formatting

option, 345
comments. See also Code view; HTML

(Hypertext Markup Language)
Coding toolbar, removing comments 

in, 335
showing/hiding, 88

compatibility. See also browser
compatibility

AP element compatibility, setting, 245
Contribute feature and, 475

complete storyboards, 9
completion of site, 2-3
Component Inspector panel, 49
connection speed, setting, 53
containers, displaying text in, 364
Continuous Tone palette, 64
contrast of images, 152
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Contribute feature, 475
Copy File As dialog box, 135
copying/pasting, 100-101

code, 333
Fireworks images, 140-141
History panel steps between documents,

copying, 511
image map hotspots, 176
Photoshop images, 136-137
preferences, setting, 102
snippets, 405

cropping
images, 150, 154

CS Live services, 296-297
CSS (Cascading Style Sheets), 29, 67, 207.

See also AP elements; forms
advanced styles, 209, 231
attaching external style sheet, 216
attribute style, 208

creating, 212
backgrounds

setting, 222
styles, changing settings for, 250

borders
properties, setting, 223
styles, changing settings for, 251

breakdown of, 208
browser compatibility, checking for, 234,

458-459
character (inline) style, applying, 215
classes, 209

for tables, 201
code formatting preferences, 236-237
Coding toolbar options, 335
colors for ID selector, 232
with Copy and Paste Special, 101
copying/pasting, setting for, 102
creating Web page with CSS layout, 210-

211
CSS rules, 214-215

modifying existing rule, 224
moving, 226-227
Relevant CSS tab, using, 230

custom CSS layouts, 211
default properties, 81
deleting

CSS rule, 225
design-time style sheets, 239

internal style, 218
design-time style sheets, using, 239
disable CSS property, 219, 228
embedded CSS code, formatting, 237
enable CSS property, 219, 228
entire style sheet, modifying, 225
external styles, 209

attaching external style sheet, 216
creating, 213
modifying external style sheet, 217

file formats, 79
fonts

for ID selector, 232
setting, 222

formatting code preferences, setting,
236-237

hidden content, displaying, 89
hover class, 231
HTML (Hypertext Markup Language)

compared, 208
ID selectors

applying, 233
creating, 232
working with, 231

Inspect, 229
introduction to, 242
manually formatting CSS code, 237
paragraph style, applying, 214
preferences

code formatting preferences, setting,
236-237

styles preferences, setting, 238
properties, setting, 222-223
Properties panel, 220-221
pseudo-classes, 231
Relevant CSS tab, using, 230
sample pages with, 25
sample style sheet, using, 217
selecting, 61
selector declaration, 224

name, changing, 225
shorthand preferences, setting, 238
showing/hiding style sheets, 239
spry widgets, editing, 378
styles

creating, 212-213
paragraph style, applying, 214

Styles panel, using, 219
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CSS (continued)
tag style method, 208-209
text style, creating and applying, 116-117
types of styles, 209
visual aids, using, 87

CSS-P (Cascading Style Sheets-Positioning),
245. See also AP elements

applying styles, 248
creating styles, 247
manually changing, 246
properties, modifying, 250-251

CSS Rule Definition dialog box, 222
CSS rules. See CSS (Cascading Style

Sheets)

D
data files for ActiveX objects, 291
dates and times, adding, 97
decorative fonts, 96
Default Color button, 64
default images folder, 477
definition lists

creating, 112
modifying, 113

deleting. See also CSS (Cascading Style
Sheets); tables; templates

behaviors, 359
closing tags, 346
columns in site, 485
commands, 515
favorites, 414
Flash Video component, 285
font combinations, 103
frames, 271
guides, 57
HTML comments, 335
library items, 421
links, 179
menu bar items, 385
properties, 369
remote files, 504
shortcuts/shortcut sets, 58-59
site files or folders, 74
snippets, 405
spry effects, 396-397

demographic studies, 7
description tag, 332

Design Notes, 474
columns, associating, 485
enabling, 486
erasing, 486
linking with files, 487
viewing, 488

design-time style sheets, using, 239
Design view, 30, 31, 326

assets, dragging, 410
comments in, 333
Reference panel, accessing in, 325
visual aids in, 87

Device Central. See Adobe Device Central
dictionaries, selecting, 61
diff tool, 496-497
digital cameras. See Adobe Bridge
disable/enable CSS, 219, 228
disabled options, 43
discovery sites, 7
dither for images, 148
docking/undocking panels, 48
documents

History panel steps between documents,
copying, 511

importing/exporting document 
data, 94-95

links to Microsoft documents, 95
new document preferences, 

setting, 62-63
paths, document-relative, 165
size, displaying, 52
from templates, 24
untitled documents, list of, 469
viewing multiple documents, 31

Document toolbar, 44
Document window

cascading and tiling, 39
examining, 42-43
resizing, 52

double-byte inline input, allowing, 61
double-clicking on text, 98
downloading. See also Flash

Adobe applications, 13
behaviors, 354
estimated download time, displaying, 52
image download size, displaying, 53
images affecting time, 143
snippets, 401
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statistics preferences, 472
templates, 428

drag-and-drop
assets, 410
CSS rules, 227
external JavaScript library items, drag-

ging, 423
Drag AP Element behavior, 370-371
Draw AP Div tool, 243
Dreamweaver API reference, 37
Dreamweaver Exchange Web site, 469
DTD (document type), 62

selecting, 85
Drupal, 343
dynamic form elements, 300
dynamic images, 134
dynamic pages, 69
dynamic text, showing/hiding, 89

E
editable regions. See templates
editing, 404-405. See also Flash; images

Browser list, 35
external JavaScript scripts, 425
Fireworks images, 141
jump menus, 317
library items, 418-419
Photoshop images, 138-139
properties, 369
spry widgets, 378

Edit NoFrames Content command, 265
Edit Snippet button, 404
Edit Tag mode, Quick Tag Editor in, 337
EDML files, 79
effects

behavior effects, adding, 360-361
spry effects, adding and removing, 396-

397
8-second rule, 143
elastic CSS layout, 210
elements. See also AP elements; assets;

behaviors; Flash elements; forms;
frames and framesets; invisible ele-
ments; Show/Hide Elements behav-
ior; spry widgets

accessibility, adding, 467
selecting, 90

email links
adding, 170
modifying, 169-170

embedding
for ActiveX objects, 291
showing/hiding embedded styles, 88
sound files, 287

empty tags, removing, 469
<em> tag

allowing, 61
using, 115

enabled options, 43
encoding

frame encoding, changing, 272
selecting, 62
specifying encoding type, 85

errors on previewing Web pages, 34
errors, identifying in Code view, 335
events. See also specific events

associated events, 351
changing event for behavior, 357
specific browser, showing events 

for, 353
existing Web page, opening, 28
exiting Dreamweaver, 40
Expanded table mode, 187
expander arrow, 46
expanding/collapsing

Coding toolbar options, 334
Files panel, 71
panels, 46-47

exporting. See importing/exporting
extending Dreamweaver, help with, 37
extensions. See also Adobe Extension

Manager
Business Catalyst, 502-503
CSS styles, changing settings for, 250
selecting, 62

external editors. See images
external JavaScript libraries

creating Javascript files, 422-423
dragging JavaScript library items, 423
editing scripts, 425
inserting, 424

external style. See CSS (Cascading Style
Sheets)

eyedroppers for images, 149
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F
fade. See appear/fade
favorite assets

adding or deleting, 414
Favorites folder, grouping assets in, 415
nicknames, creating, 415

file formats
different formats, saving files in, 78
list of, 79

files and folders, 67. See also dependent
files; extensions; Files panel; local
root folder; remote folders; testing
servers

closing, 39
default images folder, 477
deleting, 74
Design Notes, linking, 487
different formats, saving files in, 78
existing file, opening, 28
Flash file types, 280
HTML files, 322
image folder, defining, 132
levels of folders, displaying, 70
local root folders, 476
setting up site folders, 69
site preferences, setting, 490-491
snippet folder, creating, 406
SpryAssets folder, 376-377
Subversion, using, 500-501
templates, storing, 23
transferring files to and from remote

site, 494-495
types of files

changing, 67
list of, 29

updating links when moving files, 60
working with, 68

Files panel
creating files in, 73
customizing appearance of, 474
in expanded view, 71
finding files in, 76-77
managing files and folders in, 74-75
moving files or folders in, 75
new site folder, creating, 75
opening files in, 72
recently modified files, finding, 77

refreshing, 72
Subversion, using, 500-501
viewing files in, 70
working with, 492-493

File Synchronization, 504-505
File View Columns options, 485
filters for CSS properties, 223
finding/replacing, 120-121, 507. See also

tags
advanced find and replace

for tags, 520-521
for text, 518-519

Files panel, files in, 76-77
last search, repeating, 519
queries, creating and using, 522
recently modified files, 77
Results panel, using, 122
templates, editable regions in, 448

Find Next command, 119
Find Selection command, 119
firewalls, 479

settings for, 490-491
Fireworks, 2.

copying/pasting images, 140-141
editing images in, 155
GIF images with, 130
optimizing images with, 142
PNG format, 131
Script files, 79

fixed CSS layout, 210
fixed fonts, selecting, 128
fixing broken links, 454
Flash, 2.

autoplay, 285
backgrounds

for movies, 283
borders

for movies, 283
downloading

video, 284-285
editing

files, 282
Flash Video component, 285
movies, 282

file types, 280
height

for movies, 282
for video settings, 284
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inserting movies, 281
names

for movies, 282
PNG format, 131
properties of movie, changing, 282-283
URLs

for video, 284
video, inserting, 284-285
widths in movies/videos, 284

Flash Player code, 285
Flash Video files, 280
flexibility of site, 451
flow chart for site, 6
FLV format, 284-285
folders. See files and folders
fonts, 91. See also CSS (Cascading Style

Sheets); Flash; styles
Change Property behavior for, 368
changing text font, 104
for headings, 84
link font, setting, 83
modifying combinations, 103
nested font tags, combining, 463
preferences, setting, 128
setting font properties, 82
size, modifying, 105
special characters and, 96
table text, 193

formatting. See also tables
characters, 104-105
Coding toolbar options, 335
copying/pasting, setting for, 102
CSS (Cascading Style Sheets) code pref-

erences, setting, 236-237
images, 148
multiple changes, making, 105
paragraph text, 106
with Paste Special, 100-101

forms, 299
aligning image buttons, 311
buttons, 304

image buttons, inserting, 311
objects, inserting, 304
working with, 310

checkboxes
inserting, 305
modifying, 308

creating forms, 302-303
CSS rules

for buttons, 310
for image buttons, 311
for lists/menus, 309
for radio buttons/checkboxes, 308
for text fields/text areas, 307

dynamic elements, 300
creating, 312

elements, 300
dynamic form elements, 300, 312
example code for, 318

example code for, 318-319
explanation of, 300-301
GET method, 303
image buttons, inserting, 311
Input Tag Accessibility Attributes dialog

box options, 305
inserting form objects, 304-305
jump menus, 316-317
labels

for buttons, 310
for objects, 305

layout for, 303
lists/menus

inserting, 305
jump menus, 316-317
working with, 309

naming, 303
password files, creating, 307
POST method, 303
radio buttons

inserting, 305
modifying, 308

showing/hiding
delimiters, 89
fields, 88

tables for controlling, 313
text fields/text areas

inserting, 304
modifying, 306-307
type designations for, 307

Validate Form action, 350
validating, 300

example code for, 318-319
HTML form data, validating, 314-315
Validate Form action, 350
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frames and framesets, 259
accessibility values, editing, 270
adding

frames, 271
frameset information, 267

borders, 87, 266
modifying, 273
properties, changing, 274-275

click and drag, creating frameset with,
263

colors of borders, modifying, 274
deleting frames, 271
down and dirty links, creating, 278
elements

frame elements, 261
frameset element, 260

information for browser with no frame
support, 265

inserting framesets, 263
introduction to, 260-261
names

changing, 273
link names, changing, 278

new file, saving frames and framesets
as, 268-269

opening Web page in, 264
properties

border properties, changing, 274-275
frame properties, changing, 272-273
size properties, modifying, 275

quick frame links, creating, 278
resizing frames, 270
sample, creating frameset from, 262
saving framesets, 268-269
selecting framesets and, 266
sizing/resizing

frames, 270
frameset size properties, 

modifying, 275
targeted links, creating, 276-277
text, displaying, 364
title for frameset page, setting, 275

free association concept, 4
Freedom Scientific, JAWS for Windows, 466
Freemind Web site, 5
FTP (File Transfer Protocol)

connection options, setting, 490-491
links, 164

Remote Info categories, 478-479
Site FTP log, displaying, 495

G
gamma of image, adjusting, 131
Garamond font, 91
general fonts, 103
general preferences, setting, 60-61
GET method for forms, 303
GIF files, 29

images, 130
tracing images in, 86, 204
transparent GIFs, 256

goals of site, 2
Go To URL behavior, 350

working with, 362
graphics. See images
grids and guides. See also rulers

frame document, laying out, 262
working with, 56-57

grouping/ungrouping panels, 49
grow/shrink, 360

spry effect, adding, 396
guides. See grids and guides
GUI (graphic user interface), 16
GW Micro, Window-Eyes, 466

H
Hand tool, 52
headers and footers, snippets for, 400
headings

frame headings, changing, 272
page properties, setting, 84

head tags, working with, 332
height. See also Flash; tables

for ActiveX objects, 291
of AP elements, 245, 247
of horizontal rules, 109
image height, changing, 144, 150
for Java applets, 289

help, 36-37
hexadecimal codes, 105
hiding. See showing/hiding
hierarchical storyboards, 9
highlighting, 360

library item highlight color, 66, 420
preferences, setting, 66
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spry effects, adding, 396
History panel, 507. See also commands

clearing, 508
closing, 508
copying steps between documents, 511
defining History steps, 517
description of, 508
managing commands, 515
number of steps, changing, 61, 127, 517
opening, 508
replaying steps from, 510
running History commands, 514
saving steps as commands, 512-513
undoing/redoing, 127

multiple History steps, 509
Undo/Redo slider, 508
workarounds for steps not recorded, 513

home page
setting page as, 80

horizontal rules
inserting, 108
modifying, 108-109

Host Directory for FTP, 478
hotspots. See image maps
HSB sliders, 65
HTML (Hypertext Markup Language), 29, 67,

321. See also Code view; Code View
Live; events; forms; frames and
framesets; named anchors; Quick Tag
Editor; spry widgets; Tag inspector

balanced code, checking for, 460-461
Browser Compatibility Check 

(BCC), 458-459
browser-safe scripts, inserting, 347
cleaning up, 462-463

Microsoft Word HTML, 464-465
comments

deleting, 335
inserting, 333

with Copy and Paste Special, 101
copying/pasting, setting for, 102
CSS (Cascading Style Sheets) 

compared, 208
description of, 322-323
explanation of, 322-323
file formats, 79
head tags, working with, 332
opening Web pages with, 28

properties, changing, 81
reports on attributes, 468
selecting, 61
shortcuts as HTML, exporting, 59
spry HTML data set, displaying, 388-389
syntax of code, 336
Tag Chooser, using, 339

HTTP address for site, 477
HTTP links, 164

adding, 168-169
hue, 64-65
hybrid CSS layout, 210

I
icons

Design Notes icons, 488
ideas, 4
IDs. See also CSS (Cascading Style Sheets)

for form objects, 305
Illustrator, 2

shortcuts, 58
image buttons in forms, 311
image maps

creating client-side image map, 174
modifying hotspots, 176
server-side image maps, 174
showing/hiding, 88

Image Preview dialog box, 141
ImageReady, 155
images, 129. See also Adobe Bridge; Adobe

Stock Photos; backgrounds;
Fireworks; frames and framesets;
Photoshop; preloading images;
rollover images; tables

accessibility options, editing, 145
aligning, 146-147
assets, displaying, 409
brightness, changing, 152
contrast, changing, 152
cropping, 150, 154
default images folder, 477
download size, displaying, 53
external editors, 155

file type, setting, 156-157
file type preferences, setting, 156-157
Fireworks images, inserting, 140-141
folder, defining, 132
inserting, 134-135
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images (continued)
low source images, 143
optimizing, 143, 148-151
placeholder, inserting, 160-161
previewing, 150-151
Properties panel

aligning images with, 146-147
modifying with, 145

resizing, 144-145
rollover images, creating, 158-159
sharpness, changing, 153
Swap Image behavior, 350, 366-367
Swap Image Restore 

behavior, 350, 366-367
tracing image, inserting, 86
URL to image, applying, 413
Web-friendly graphics, 130-131
zooming on, 151

<i> tag, 115
<img> tag, 144
importing/exporting

Microsoft document data, 94-95
shortcuts as HTML, exporting, 59
tabular data, importing, 93
table data, 194-195
templates, XML data to, 449-450

Inconsistent Region Names dialog box, 443
InContext Editing

adding CSS formatting, 441
creating editable region, 440-441
creating repeating region, 438-439
deleting, 439

indenting
code, 345
CSS source code options, 236
for HTML code, 329
for lists, 110
paragraph text, 106

InDesign. See Adobe Bridge
index.htm, 80
Info bar, 229, 341

syntax error alert, in Info bar, 329, 335
information-gathering, 7
inheritance, 230
Input Tag Accessibility Attributes dialog box,

305
Insert HTML mode, Quick Tag Editor in, 337

Insert toolbar, 43, 44
objects, prompt on inserting, 60

Inspect, 229
Inspiration Web site, 4
installing

Dreamweaver, 13
Intel-based Macintosh systems, 11
interlaced browser display, 149
Internet. See browsers; remote site; Web

pages; Web sites
Internet Explorer, 34

ActiveX controls in, 290
events, support for, 351, 352
Web-safe colors, 64

invalid code, Coding toolbar options, 335
invisible elements, 87

selecting, 90
working with, 88-89

invisible maps, 87
IPv6 transfer mode, 479
ISP (Internet service provider), 490
italicizing

characters in text, 104
with Copy and Paste Special, 101
copying/pasting, setting for, 102
for headings, 84
for links, 83
table text, 193

J
Japanese characters, enabling inline input

for, 61
Java applets, 279

inserting, 288
preferences, modifying, 289

Java files, 79
JavaScript. See also AP elements; behav-

iors; external JavaScript libraries;
spry widgets

attaching behaviors to links, 177
Call JavaScript behavior, 373
executing, 373
files, 79
null/script links, creating, 177
rollover image name, 158, 159
showing/hiding, 88

Java Server pages, 79
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JAWS for Windows, 466
Joomla, 343
JPEG/JPG files, 29

images, 130-131
tracing images in, 86, 204

JRun custom library tags, inserting, 339
JSP files tags, inserting, 339
jump menus, 177, 316-317

editing, 317
text in, 316

justifying paragraph text, 106

K
keyboard shortcuts. See shortcuts
keywords, 4

tags, 332

L
labels. See forms
languages for spell-checking, 125
Lasso files, 79
last saved version of document, reverting

to, 27
launching Dreamweaver, 14-15
layers. See AP elements
layouts for forms, 303
Layout table mode. See tables
left alignment of paragraph text, 106
libraries. See also external JavaScript

libraries; library items; tag libraries
disconnecting library item from, 417
files, 79
introduction to, 399, 408

library items, 408. See also external
JavaScript libraries

creating, 416
deleting, 421
disconnecting item from library, 417
editing, 418-419
filename and location, displaying, 419
highlighting color preferences, setting,

66, 420
list, displaying, 409
planning for, 408
recreating missing or deleted items, 421
renaming, 421
updating on page or site, 420

using, 417
linear storyboards, 9
line breaks

for code, 345
controlling, 107
with Copy and Paste Special, 101
copying/pasting, setting for, 102
showing/hiding, 88

line numbers
Coding toolbar options, 334
for HTML code, 329

line spacing. See spacing
links, 163. See also email links; Flash; paths

automatically updating, 180
broken links, finding and fixing, 452-454
cache files, creating, 180-181
case-sensitive links, checking, 477
deleting, 179
frame links, changing, 272
for image placeholders, 160-161
menu links, adding, 385
to Microsoft documents, 95
modifying, 178
named anchor, adding, 172-173
null links, creating, 177
opening linked pages, 182-183
orphan links, 184, 453
properties, setting, 83
relative path for new links, 

setting, 166-167
relative to documents, 477
script links, creating, 177
sitewide changes to, 184, 454-455
to sound files, 286
targeted links, creating, 276-277
testing, 182-183, 452-454
text links, adding, 168-169
types of, 164
updating, 180-181

when moving files, 60
link tag, 332
liquid CSS layout, 210
List Properties dialog box, 113
lists. See also definition lists; forms;

ordered/unordered lists
CSS styles, changing settings for, 251
modifying, 113
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Live Code View, 328
color preferences, 348

LiveDocs data base, 37
Live View, 32-33

testing link, 182-183
local files, 496-497
Local Info, 474

defining, 476-477
Local/Network options, 479-480
local root folder, 67, 476

creating, 11, 19
elements of site in, 18
for relative path for new links, 166
setting up, 69
working with, 68

Locate in Site command, 76-77
locked regions, color preferences for, 66
Lock Guides, clearing, 57
logical styles, 114
login for WebDAV server, 480
logos, snippets for, 400
Long Description input box, 135
long descriptions, using, 467
looping

Flash/Shockwave movies, 283
low source images, 143
luminosity, 64-65

M
Macintosh systems, 11

browsers on, 34
case sensitivity of file names, 27
color palette, 64
launching Dreamweaver in, 14-15
requirements for, 12

macros. See snippets
magnification, setting, 52
mailto links, 164
Manage Sites dialog box, 20
managing sites. See also remote site

advanced site definitions, setting, 474-
475

maps. See also image maps; site maps
mind maps, creating, 4-5

margins
frame margins, changing, 273
setting page margins, 82

marketing plans, creating, 8
maximizing. See minimizing/maximizing
meetings. See Adobe Acrobat Connect
menu bars, 43

spry menu bar widgets, 384-385
menus, 43. See also forms

spry menu bar widgets, working with,
385

merged cells. See tables
message for Flash video, 285
meta tags, 332
Microsoft Excel

importing content from, 94
links to document, creating, 95

Microsoft Word
cleaning up HTML, 464-465
importing content from, 94
links to document, creating, 95
working with, 101

MIDI files, linking or embedding, 286
MindGenius Web site, 4
mind maps, creating, 4-5
Mindmap Web site, 4
Mind tools Web site, 4
minimizing/maximizing, 43. See also

zooming; Zoom tool
panels, 45

monitors, rulers with, 55
motivation for site, 3
Mouse-Over region colors, 66
MOV files, linking or embedding, 286
movies. See also Flash; QuickTime;

Shockwave
assets, displaying, 409

moving
AP elements, 253
Coding toolbar options, 335
CSS rules, 226-227
Files panel, files or folders in, 75

MPEG files, linking or embedding, 286
MP3 files, linking or embedding, 286
multimedia. See Flash; Shockwave
multiple documents, viewing, 31

N
named anchors

adding, 172-173
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links, adding, 173
showing/hiding, 88

naming/renaming. See also Flash
ActiveX objects, names for, 291
AP elements, 248
case sensitivity of file names, 27
class names, 209
columns in site, 485
commands, 515

naming/renaming
CSS selector declaration, 225
favorite assets, creating nickname 

for, 415
forms, 303
Java applets, names for, 289
library items, 421
Local Info, site name in, 476
local root folder, 68
panel sets, 50-51
pasting, renaming form items when, 346
rollover images, 158
shortcut sets, 58
snippets or snippet folders, 406
styles, renaming, 118
templates, 431
Web pages, 26
workspaces, 50-51

nesting. See also tags; templates
AP elements, 244
lists, 110
tables, 206

Netfirms Web site, 7
Netscape Navigator. See also plug-ins

AP element compatibility, setting, 245
events, support for, 351, 352
Web-safe colors, 64

New Document dialog box
sample file designs in, 25
selecting to show, 63
template designs, selecting, 24

New Library Item button, 416
news links, 164
new Web site, creating, 18-19
nicknames for favorites assets, 415
noframe element, 261

information for browser with no frame
support, 265

Non-Breaking Space command, 96

null links, creating, 177
numbered lists. See ordered/unordered lists

O
objective of site, 3
OLE controls, 290
Omniture Web site, 7, 37, 296
onBlur event, 351
onClick event, 351
onDblClick event, 351
onError event, 351
onFocus event, 351
onKeyDown event, 351
onKeyPress event, 351
onKeyUp event, 351
onLoad event, 351
onMouseDown event, 351
onMouseMove event, 351
onMouseOut event, 351
onMouseOver event, 158, 350-351
onMouseUp event, 351
onUnload event, 351
Open Browser behavior, 177

working with, 363
Open dialog box for templates, 431
opening

documents with tabs, 60
Files panel, files in, 72
linked pages, 182-183
panels, 46
predefined sites, 20
Related Files toolbar, 340-341

opening tags, 322
Optimize to Size button, 149
optimizing images, 143, 148-151
ordered/unordered lists

creating, 110-111
CSS properties, setting, 223
modifying, 113
paragraph text, converting, 106
text, creating lists with, 111

O'Reilly reference manuals, 324
orphan links, 184, 453
outdenting Coding toolbar options, 335
overlapping of AP elements, preventing,

252
Override Case of option, 345
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P
page breaks, setting, 223
page positions, setting, 223
Page Properties dialog box, 69, 81

Appearance category, 82
Headings category, 84
Links category, 83
Title/Encoding category, 85

panel gripper, 46
Panel Options menu, 46-47
panels, 41, 42. See also Files panel; History

panel
docking/undocking, 48
expanding/collapsing, 46-47
grouping/ungrouping, 49
header bars, 43
information area, expanding and 

collapsing, 47
opening/closing, 46
showing/hiding, 51

panel sets, 50-51
paragraphs. See also styles

formatting text in, 106
line spacing, controlling, 107
plain paragraph after reading, switching

to, 61
parameters

for ActiveX objects, 291
for Flash/Shockwave movies, 283
for Java applets, 289

parentheses balance, checking for, 460-461
passive FTP, 479
passwords

forms, creating field for, 307
for FTP access, 478-479
for WebDAV server, 480

Paste Special command, 100-101
pasting. See copying/pasting
paths, 165

relative path for new links, 
setting, 166-167

Pewinternet Web site, 7
Photoshop, 2. See also Adobe Bridge

copying/pasting images, 137-138
editing images in, 138-139
inserting images from, 140-141
shortcuts, 58

Smart Objects, 136-139
tracing images in, 204

PHP files, 29, 79
tags, inserting, 339

physical tags, 114
placeholders for images, inserting, 160-161
planning, 1-3

mind maps, creating, 4-5
for search engine submission, 8

plug-ins. See also Check Plug-in behavior;
QuickTime

checking for, 294-295
inserting content, 292
playing, 293
troubleshooting, 293

PNG files
images, 131
tracing images, 86, 204

Point/Pica size, choosing, 55
Point To File icon, 173
Popup Message behavior, 350

working with, 364-365
positioning form objects, 305
POST method for forms, 303
Postscript Point/Pica size, 55
predefined sites, opening, 20
preferences. See also Code view; CSS

(Cascading Style Sheets)
accessibility preferences, setting, 466
AP element preferences, setting, 245
for copying/pasting, 102
font preferences, setting, 128
general preferences, setting, 60-61
highlighting color preferences, setting,

66
History panel preferences, setting, 517
Java applet preferences, modifying, 289
new document preferences, 

setting, 62-63
Preferences dialog box

AP Element section, 245
Code Coloring section, 348
Code Format section, 345
Code Hint section, 344
Copy/Paste section, 102
File Types/Editors section, 156-157
invisible elements, selecting, 88-89
links, updating, 180
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preloading images, 350
rollover images, 159
working with, 366

Preview In Browser feature, 34
previewing

assets, 410
Flash movie content, 283
images, 150-151
pages in Live view, 32-33
relative path for new links, 166-167
synchronized files, 505
Web pages, 34-35

Preview Using Temporary File option, 166
Primary Browser, 35
primary fonts, 103
printing code, 329
prioritysubmit Web site, 8
Program window, 43
Progressive Download Video, 284
properties. See also frames and framesets

adding, 369
AP element properties, 

modifying, 250-251
Change Property behavior, 368-369
CSS properties, setting, 222-223
CSS properties, in Properties panel, 

220-221
CSS-P (Cascading Style Sheets-

Positioning) properties, 
modifying, 250

deleting, 369
editing, 369
Flash movie properties, 

changing, 282-283
for image placeholder, 160-161
Shockwave movie properties, changing,

282-283
table properties, changing, 200-201

Properties panel. See also images
Crop button, 154
with spry validation widgets, 382-383

Property Inspector, 42, 43
Flash movie controls, access to, 281
proportional fonts, selecting, 128
proportions of images, resizing, 144
pseudo-classes in CSS (Cascading Style

Sheets), 231

Q
queries, creating and using, 522
quick frame links, creating, 278
Quick Tag Editor

Code Hints with, 330-331
in Edit Tag mode, 337
in Insert HTML mode, 337
opening, 336
syntax of code, 336
in Wrap Tag mode, 337

QuickTime, 279
content, inserting, 292
linking or embedding MOV files, 286

quitting Dreamweaver, 40

R
radio buttons. See forms
RA files, linking or embedding, 286
RDS (Remote Data Services) options, 481
read-only file warnings, setting, 60
RealPlayer, 286

content, inserting, 292
recently modified files, finding, 77
recently opened Web page, opening, 29
reference help, 37
Reference panel, 324-325

specific information, accessing, 325
Refresh button, Files panel, 492
refreshing Files panel, 72
refresh tag, 332
regions. See templates
regular expressions

for tag find and replace, 521
for text find and replace, 519

Related Files toolbar, 340-341
filtering, 217
preferences, 340

relative positioning of AP elements, 246
Relevant CSS tab, using, 230
remote folders, 67

setting up, 69
working with, 68

Remote Info, 474
defining, 478-481
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remote site
checking in/checking out site 

files, 498-499
comparing local and remote 

files, 496-497
file preferences, setting, 490-491
Files panel, managing files with, 492-493
transferring files to and from, 494-495

Remove Event button, 359
renaming. See naming/renaming
Rendering toolbar, 44
reopening documents on startup, 60
repeating background, setting, 82
replacing. See finding/replacing
replaying History panel steps, 510
reports

accessibility reports, creating, 467
saving, 470-471
testing sites, running reports for, 468-469
viewing, 470

Report Settings button, 468
resizing. See sizing/resizing
resizing table columns and rows, 197
Results panel, 122
rewinding Flash video, 285
RGB color mode, 64-65
Rich Internet Applications, 280

help, 37
right alignment of paragraph text, 106
rollover images

with AP elements, 254-255
creating, 158-159
customizing, 159
link colors, 83
preloading, 159
showing/hiding, 254-255

root folders, creating, 10
rulers

working with, 55

S
Safari, 34
samples

creating Web page from, 25
page sketches, 5

saturation, 64-65
Save As dialog box

different formats, saving files in, 78
file type, changing, 67

saving. See also templates
finding/replacing query, 120
framesets, 268-269
last saved version of document, revert-

ing to, 27
reports, 470-471
searches, 325
Web pages, 26-27

scaling for Flash/Shockwave movies, 283
scripts. See also external JavaScript

libraries
assets, displaying, 409
showing/hiding, 88
snippets for, 400

scrolling display, changing, 273
search engines, 8
searchenginewatch Web site, 8
searching. See finding/replacing
Secondary Browser, 35
secondary fonts, 103
secure FTP (SFTP), 479
Select All command, 99
Selection submenu, 333
selector declaration. See CSS (Cascading

Style Sheets)
Select tool, 52
servers. See also FTP (File Transfer

Protocol); testing servers
technologies, 11
URI for Flash video, 284

server-side files, 79
showing/hiding, 89

server-side image maps, 174
Set Text behavior, 364
Set Text Of Status Bar behavior, 177
shading of horizontal rules, 109
shakes, 360

spry effects, adding, 396
sharing

columns in site, 485
snippets, 405

sharpness of images, changing, 153
Shockwave

assets, displaying, 409
inserting movies, 281
properties of movie, changing, 282-283



Index 549

shortcuts, 3, 41
creating shortcut set, 58
deleting, 58-59
guides, working with, 57
HTML, exporting as, 59
on Macintosh systems, 15
for previewing pages, 35
for snippets, 403

shorthand CSS preferences, setting, 238
Show/Hide Elements behavior, 350

working with, 372
showing/hiding. See also forms

AP element borders, 244
columns in site, 485
CSS style sheets, 239
HTML code, hidden characters for, 329
library item highlighting, 420
panels, 51
rollovers, 254-255
table column widths, 190
toolbars, 44
visual aids, 87

single-clicking on text, 98
Site Files View, 70
site specific code hints, 343
site reports. See reports
site root

option, 166
relative paths, 165

sitewide link changes, making, 184, 454-455
sizing/resizing. See also Flash; frames and

framesets
AP elements, 253
Assets panel, 414
document size, displaying, 52
Flash/Shockwave movies, 282
font sizes, changing, 105
image map hotspots, 176
images, 144-145
Point/Pica size, choosing, 55
Split view, panes in, 326
Status bar, setting window size from, 53
of table text, 193

sketches of sample page, 5
skin for Flash video, 284
slides, 361

spry effects, adding, 396

Smart Objects, Photoshop, 136-139
Snap to Grid/Snap to Guide, 56
snippets

block snippets, 401
creating, 407
editing, 405

creating, 407
deleting, 405
downloading, 401
editing, 404-405
example of, 400
folder for snippets, creating, 406
inserting, 402
introduction to, 399-401
keyboard shortcuts for, 403
recent snippet, inserting, 403
renaming, 406
sharing, 405
wrap snippets, 401

adding, 403
creating, 407
editing, 405

Snippets panel, 399
sorting assets, 414
sorting table data, 199
sounds

files, linking or embedding, 286-287
spacer images. See tables
spacing

characters, spaces between, 96
controlling line spacing, 107
with Copy and Paste Special, 101
copying/pasting, setting for, 102
CSS properties, setting, 222, 236
multiple consecutive spacing, 

allowing, 61
spam blockers, 168
special characters. See characters
speed

file transfer speed, 472
of site, 451

spell-checking, 124-125
dictionaries for, 61
languages for, 125

splash screens, 281
split cells. See tables
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Split view, 30, 31, 326
Coding toolbar, 334-335
resizing panes in, 326
visual aids in, 87

Split Code view, 30, 31
SpryAssets folder, 376

defaults, changing, 377
Spry framework help, 37
spry regions

creating, 392-393
repeat list, creating, 394
repeat regions, creating, 392-393

spry tabbed panels, 380
spry widgets

accordion panels, 380
advanced site definitions for, 475
appearance, changing, 379
collapsible panels, 380
customizing, 395
data sets, HTML or XML, 398-391
editing, 378
effects, adding and removing, 396-397
inserting, 376-377
introduction to, 375
menu bar widgets, 384-385
regions, creating, 392-393
repeating list, 394
selecting, 378
tables, creating, 389, 391
tooltip, 386-387
validation widgets, 382-383
working with, 380-381
XML data set, identifying, 390

squishes, 361
spry effects, adding, 396

stacking order. See AP elements
Standard table mode. See tables
Standard toolbar, 44
Start menu, 29
startup, reopening documents on, 60
static pages, 69
statistics of download, gathering, 472
Status bar, 43. See also text

connection speed, setting, 53
Set Text Of Status Bar behavior, 177
using, 52
window size, setting, 53

Stock Photos. See Adobe Stock Photos
storyboards, creating, 9
streaming Flash video, 284-285
<strong> tag

allowing, 61
using, 115

Style popup, 118
styles. See also CSS (Cascading Style

Sheets); CSS-P (Cascading Style
Sheets-Positioning)

built-in text style, applying, 114-115
for characters, 104
CSS text style, creating and 

applying, 116-117
for form objects, 305
logical styles, 114
renaming styles, 118
size and font style, applying, 115
for table text, 193
turning off/on, 385

Style toolbar, 44
submission of site, 8
Subversion

enabling, 483
using, 500-501

Swap Image Restore behavior, 350
working with, 366-367

Swap Images behavior, 350
working with, 366-367

SWF format, 280
switching

between table modes, 187
between Web pages, 31

Symbols font, 96
synchronizing

comparing files while, 497
displaying information on, 505
Local/Network options, 479-480
for RDS, 481
site files, 504-505
for WebDAV server, 480

syntax coloring for HTML code, 329
syntax error alerts in Info Bar, 335
system requirements, 12

T
tab index
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for form objects, 305
for links, 169

tables, 185
adding columns or rows, 196
alignment, 201

captions, aligning, 189
Layout mode, changing in, 201
of nested tables, 206
of text, 193
of tracing images, 205

AP elements to tables, 
converting, 256-257

backgrounds
cell backgrounds, formatting, 203
setting, 201

borders, 87, 201
cell border colors, 203

captions, entering, 189
cell padding

formatting, 200
values, 189

cell spacing
formatting, 200
values, 189

classes, 201
colors, 201

of text, 193
content to table, adding, 192-193
deleting

columns and rows, 196
empty layout cells, 189

Expanded mode for, 187
exporting table data, 194-195
formatting, 200-201

cells, 202-203
text, 193

forms, controlling, 313
header positions, 189
heights

clearing, 201
modifying, 191

images
adding, 192
cells, formatting for, 203
tracing images, 204-205

importing table data, 194-195
merged cells, 198

formatting, 203

nested table, creating, 206
pixels, converting widths and heights 

to, 201
placement of cells, modifying, 202
process for creating, 186
properties of table, changing, 200-201
repeating tables, creating, 435
resizing columns and rows, 197
showing/hiding column widths, 190
sorting table data, 199
split cells, 198

formatting, 203
spry tables, creating, 389, 391
Standard mode, 187

inserting table in, 188-189
nesting table in, 206
properties, changing, 200

summary, creating, 189
switching between modes, 187
Table ID, entering, 200
text

adding, 192-193
importing tabular data as, 93
wrapping text options, 203

tracing images, using, 204-205
widths

clearing, 201
fixed width, setting column to, 190
modifying, 191

working with, 186
tab size for code, 345
Tag Accessibility Attributes dialog 

box, 382-383
alternate text, using, 467

Tag Inspector
using, 338

tag libraries, 339
descriptor files, 79

tags. See also CSS (Cascading Style
Sheets); HTML (Hypertext Markup
Language); Quick Tag Editor; tag
libraries

advanced find and replace for, 520-521
balanced tags, checking for, 460
combining nested font tags, 463
finding/replacing

advanced find and replace, 520-521
code, tags in, 325
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tags (continued)
saving tag searches, 325

nested tags
combining nested font tags, 463
fixing, 346
redundant nested tags, 469
reports testing, 468-469

physical tags, 114
selecting, 90
third-party tags color preferences, 66

Tag selector, 52, 99, 339
target audience. See audience
targets, 385. See also Flash

links, targeted, 276-277
TD tags, 345
telnet links, 164
templates. See also Assets panel

advanced site definitions for, 475
all pages, updating, 446
attachments

detaching templates, 448
opening attached templates, 431
working with attached 

templates, 448
blank template, creating, 22
creating, 429
custom templates, creating Web page

from, 445
deleting, 431

editable regions, 432
repeating region entries, 434

detaching templates, 448
downloading, 428
editable attributes, defining, 433
editable regions, 428

creating, 23, 438-441
defining, 432
finding, 447
highlighting color preferences, set-

ting, 66
nested editable regions, colors for, 66
optional regions, creating, 436-437

existing template, creating Web page
from, 24

exporting template data as XML, 449-450
file formats, 79
finding editable regions, 447
Flash template files, 280

importing XML data, 449
inconsistent region names, 443
InContext Editing

adding CSS formatting, 441
creating editable region, 440-441
creating repeating region, 438-439
deleting, 439

introduction to, 427-428
list of templates, displaying, 409
manually updating pages based on, 447
nested templates

creating, 442-443
highlighting color preferences, set-

ting, 66
Web page from, 444

non-editable optional regions, 
creating, 436

Open dialog box, opening with, 431
opening, 430-431
optional regions, creating, 436-437
relocking editable regions, 432
renaming, 431
repeating regions, creating, 392-393,

434-435
repeating tables, creating, 435
saving, 429

Web pages as templates, 27
storing templates, 23
time-saving tips for, 447
updating, 446-447
XML data, importing and 

exporting, 449-450
testing. See also accessibility; validation

broken links, finding and fixing, 452-454
browser compatibility, 353
introduction to, 451
links, 182-183, 452-454
reports testing site, 468-469
servers, 474

testing servers, 67, 474
defining, 482
setting up, 69
working with, 68

text, 91. See also characters; copying/past-
ing; finding/replacing; Flash; fonts;
styles; tables

adding text to page, 92
advanced text find/replace, 518-519



Index 553

colors
applying, 413
changing, 105

dynamic text, 89
for image placeholders, 160-161
in jump menus, 316
links, adding, 168-169
lists with existing text, creating, 111
Open Browser behavior with, 363
paragraph text, formatting, 106
Paste Special for, 100-101
for rollover images, 159
selecting, 98-99
selection, finding text by, 119
Set Text behavior, 364
setting properties, 82
Status bar

displaying text wotj, 364-365
selecting with, 99

URL to text, applying, 413
text fields/text areas. See also forms

displaying text in, 364
spry validation widgets, 382

text files, 79
text messages, displaying, 364-365
themes, 4

sample pages with, 25
third-party file comparison tool, 496-497
tiling Document window, 39
times, adding, 97
Times New Roman font, 91
titles

frameset page title, setting, 275
for text links, 169
Web page titles, changing, 85

toolbars, 41, 43
Coding toolbar, 334-335
showing/hiding, 44
working with, 44

tooltips, adding, 385
spry tooltip, 386-387

tracing images, 86
frame tracing image, changing, 272
in tables, 204-205

Traditional Point/Pica size, 55
transparency for images, 149
transparent GIFs, 256

triple-clicking on text, 98
troubleshooting plug-ins, 293
type editing, 124

U
underline style popups, 83
undoing/redoing, 126-127. See also History

panel
Undo/Redo slider, History panel, 508
Unicode normalization form, 

selecting, 63, 85
Unicode signature (BOM), selecting, 63
untitled documents, list of, 469
unused colors, removing, 149
Update Current Page method, 420
Update Pages command, 420
updating. See also links

Fireworks images, 141
library items, 420
Photoshop images, 138-139
templates, 446-447
Web updates, obtaining, 38

URL assets
displaying, 409
image, applying URL to, 413
new URL asset, adding, 412
text, applying URL to, 413

URLs (Uniform Resource Locators). See
also Flash; Go To URL behavior; links

absolute paths and, 165
in jump menus, 317
opening Web page with, 28
rollover images linked to, 159
for WebDAV server, 480

UseableNet Accessibility Reference, 324
Use Dynamic Font Mapping check box, 128

V
validation, 455. See also forms

preferences, setting, 456
spry validation widgets, 382
Web pages, validating, 456-457
World Wide Web Consortium 

standards, 457
Validator, 456-457
VBScript files, 79

showing/hiding, 88
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version control
Subversion, enabling, 483

views and viewing
Browser Compatibility Check (BCC)

report, 235
Design Notes, 488
download statistics, 472
Dreamweaver window, viewing, 16
Files panel, viewing files in, 70
multiple documents, viewing, 31
reports, 470
switching between views, 31
Tag Inspector views, 338
working with views, 30
Zoom tool, changing view with, 54

visibility of AP elements, 245
visitor link colors, 83
visual aids, using, 87
visually impaired persons, alternate text 

for, 467
visual server markup tags, showing and

hiding, 89
VTML files, 79

W
warnings

read-only file warnings, 60
tags, fixing or removing, 346

WAV files, linking or embedding, 286
WebDAV options, 480
Web pages. See also home page; tem-

plates; testing
blank page, creating, 21
closing, 39
custom template, creating from, 445
dynamic pages, 69
existing page, opening, 28
naming, 26
nested templates, creating from, 444
previewing, 34-35
properties, setting, 81
recently opened page, opening, 29
sample, creating from, 25
saving, 26-27
static pages, 69
switching between, 31
validating, 457

Web-safe colors, 64
Web sites. See also testing; Web pages

for snippets, 401
for templates, 428

welcome screen, showing, 60
wheel storyboards, 9
whitespace

for ActiveX objects, 291
finding/replacing ignoring, 121
Flash/Shockwave movies, setting for, 283
for Java applets, 289
for tag find and replace, 521
for text find and replace, 519

whole word match
for tag find and replace, 521
for text find and replace, 519

widgets. See spry widgets
widths. See also tables

for ActiveX objects, 291
of AP elements, 245, 247
Flash video settings, 284
of horizontal rules, 109
image width, changing, 144, 150
for Java applets, 289

Window-Eyes, 466
Windows Media Player, 286
Windows systems, 11

browsers on, 34
case sensitivity of file names, 27
color palette, 64
launching Dreamweaver in, 14-15
requirements for, 12

WML files, 79
tags, inserting, 339

Wordpress, 343
word wrap

for form text, 306
for HTML code, 329

workflow reports, 468
workspace. See panel sets.
World Wide Web Consortium, 130

validation standards, 457
Web site, 7

wpromote Web site, 8
wrapping code, 345
wrap snippets. See snippets
Wrap Tag mode, Quick Tag Editor in, 337
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WYSIWYG view, 30

X
XHTML (Extensible Hypertext Markup

Language)
cleaning up, 462-463
definitions, selecting, 62

XML (Extensible Markup Language), 29
file format, 79
spry XML data set, displaying, 390
templates, importing and exporting XML

data into, 449-450
XSL format, 29

Y
Yahoo submission options, 8

Z
z-index to AP element, applying, 249
zooming

on images, 151
Zoom tool, 52

changing view with, 54
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